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1 Introduction

This document forms a quick set-up reference for using the EC0003 application with the PE0O003 hardware
to develop, test and debug C routines for CML devices. It is necessary to install LPCXpresso and download
the EC0003 with the set of CML libraries.

A practical example is given using step-by-step instructions to develop a project using the EC0003 GUI
interface and LPCXpresso. It is not intended to give a detailed explanation of the development process or the
LPCXpresso toolchain, but to illustrate how the tools can be used to create a project in a friendly and hassle-
free manner. This guide also introduces tips to guide in you through the learning process. A more detailed
explanation is given in the LPCXpresso User Guide, listed at the end of the document, see section 13

The EC0003 application bundle, with the CML libraries and LPCXpresso should be downloaded before
continuing.

It is possible to use other tools instead of LPCXpresso but because the NXP processor in the PE0003 is the
target, it is practical to use the libraries and tools provided for this chip (LPC43XX).

1.1 History

Version | Changes Date

1 First issue of document July 2015

2 Section 4.6: “Add directory path” dialog updated to show correct February 2016
path. Added supporting text regarding libraries configuration.
Section 4.6: “Properties for...” dialog updated

3 Section 8 — “LPC-Link2 Configuration” added after finding issues | February 2016
with the LPCXpresso version 7.6.2 onwards.

1.2 Glossary

CML CML Microsystems plc group of companies
EC0003 CML GUI providing a C interface and a programming path via the USB interface.
PEOO03 Evaluation Kit Interface Card.
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2 ECO0003 Installation

Download and install the LPCXpresso tools. Download the PE0O0O3 drivers from the CML website and install
them. See the PEO003 User Manual for instructions.

The ECO0003 installation includes the ‘C’ libraries. Run ‘EC0003Installer.exe’

The installation has the option to create shortcuts in the start menu and the desktop. De-select them if they
are not required.

12 CML EC0003 Bundle: Installation Options (=] )

| Check the components you want to install and unchedk the components
you don't want to install, Click Mext to continue.

Select components to install: EC0003 (required)
Documentation
Driver

Libraries

Examples

Start Menu Shortcuts
Desktop Shortouts

Space reguired: 56, 1MB

coet_|

The libraries, documentation, examples and PE0003 driver FILES are installed in a folder called CMLMicro
under ‘Documents’. It is suggested that this folder is used initially. It can be changed later as required.

L

C:\Users\xxxx\Documents\CMLMicro

[ e
@Uv| . v Libraries » Documents » CMLMicro » v|"f| Search CMLMicro ol
Organize = Share with = Burn Mew folder == » [l l@l
3¢ Favorites Docgments library Amange by Folder ~

CMLMicro
» BE Desktop Mame .
) Doc
J Driver
| Examples
J Libraries
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3 Creating a Base Project

The Base Project that will be created here is a template that can be used to create other projects quickly.

Start LPCXpresso.

Select the workspace (where your project will be held). If LPCXpresso does not ask for the workspace at

startup, go to File > Switch workspace - Other

Workspace Launcher

==

Select a workspace

LPCXpresso stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Workspace: Ch\nxp\workspace

» Copy Settings

@

- Browse...

0K

] [ Cancel

)

L

Import the CML libraries “CML_C_BundlevXX.zip” from Documents\CMLMicro\Libraries.

File > Import. Select General - Existing Projects into Workspace

r

Import

=] [ |

Select

Create new projects from an archive file or directory.

Select an import source:

type filter text

Y

(=]

4 [= General
[E ArchiveFile
1= Existing Projects into Workspace
[, File System
& Import projects(s) from XML description
E Preferences

s CfC++

> (= CVS

i » = Install

> [ Run/Debug

s = Team

®@

Finizh

Cancel

Next

Select archive file, browse “C_BundlevXX.zip”.

© 2016 CML Microsystems Plc 5 of 40
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.
Import
Import Projects
Select a directory to search for existing Eclipse projects.
() Select root directory:
(@ Select archive file: ChUsers\DGonzaler\ Documents\ CMLMicro =
Projects: M
BaseProject (BaseProject) Select All I
CML_UtilsLib (CML_UtilsLils)
Ipc_chip_43xx (lpc_chip_43w) Deselect All
lpe_chip_43:c_mD (lpc_chip_43w_mD)
PEDOO3_DriverLib (PEO003_DriverLib) =
Options
Search for nested projects
Copy projects into workspace
Working sets
[] Add project to working sets
Select...
@j MNext = Finish ] [ Cancel
h
Click Finish

In the Project Explorer is the BaseProject folder. This folder contains the file BaseProject.c which itself

contains the main() function.

Select Project - Build All. This generates the .bin file.

Start EC0003.

Connect the PEO0O03 to a power supply and to the PC. Refer to the PEO003 User Manual for more

information — see section 13.

Power up the PEO0O3.

Browse “BaseProject.bin” in “$YourWorkspace\BaseProject\Debug” and select the “.bin” file.

The program should display a message on the screen “Hello from PE0003”.

The BaseProject has been configured to use the CML libraries and does not require any other configuration.

© 2016 CML Microsystems Plc
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4  Creating a LPCXpresso Project

The wizard will be used to create a project because this avoids the detailed configuration of libraries, paths,
chip, memories, global variables and other options, required to configure a full project. This is a quick set-up
procedure that can be used for most CML target projects.

4.1 STEP 1-Open LPCXpresso and select workspace

If LPCXpresso does not prompt you for a workspace, select the workspace where you want to save your

projects.

File > Switch Workspace - Other.

4.2 STEP 2 —Import Libraries to your workspace

File > Import

Expand General and select Existing Projects into Workspace.

Click Next.

Import l_I_I_JIEI e S|
Select \“
Create new projects from an archive file or directory. E 5 I

Select an import source:

type filter text

4 [= General
[E, Archive File
1= Existing Projects into Workspace
[, File System
&; Import projects(s) from XML description
EL Preferences
4 [= CfC++
[E] C/C++ Executable
¥ C/C++ Project Settings
Existing Code as Makefile Project
. = OV

» = Install
> [= Run/Debug
> [= SVN
¢ [ Team
\?/' < Back MNext > Finish

© 2016 CML Microsystems Plc
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Select Archive File and select the “CML_C_Bundlev1_0.zip” from “Documents\CMLMicro\Libraries”.
Deselect all then select the libraries or projects you require. For this simple project select the libraries:

e Lpc_chip_43xx - Chip libraries
e PEO0003_DriverLib — PEO0OO03 peripheral libraries

e CML_UtilsLib — Libraries for the interface with EC0003

-

Import

Import Projects

Select a directory to search for existing Eclipse projects.

() Select root directory:

Projects:

@ Select archive file: ChUsers\paulbh\Documents\ CMLMicro'\Libr -

Browse...

[7]| BaseProject (BaseProject)
CML_UtilsLib (CML_UtilsLib)
lpc_chip_43wx (lpc_chip_43:x)
PED003_DriverLib (PEDDD3_DriverLil)

Options
Search for nested projects
Copy projects into workspace

[ Hide projects that already exist in the workspace

Working sets

[ Add project to working sets

14

Select All

Deselect All

Refresh

Select...

Finizsh

||

Cancel

L

Click Finish

© 2016 CML Microsystems Plc 8 of 40
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4.3 STEP 3 - Create new project

File > New - Project

Expand C/C++ and select “LPCXpresso C Project”

-

New Project

Select a wizard

Wizards:
type filter text

. [ General
4 = C/C++

[€] C Project

[E¥]) C++ Project

[} LPCXpresso C Project

@ LPCXpresso C++ Project

[4] Makefile Project with Existing Code

> (= CVS
> (= SVN

Finish

Cancel

Click Next

Select the chip model and type of project. LPC4x - LPC43xx(Cortex-M4 basic) > LPCOpen — C Project

-

| B e S

Wizard

New LPCXpresso C Project
LPC43:xx (Cortex-M4 basic) -» LPCOpen - C Project

» LPC11/LPC12
. LPC13/LPC15/LPC17 / LPC18
» LPC2x/ LPC3x
4 LPC4x
> LPC40Tx_8x
4 LPCd30 (Cortex-M4 basic)

LPCOpen - C Project

LPCOpen - C Static Library Project
C Project

C Project (Semihosted)

C Static Library Project

w1 PCd ey (T artev-RAN hacic

m

@ <Back [ Next> Ean
Click Next.
Set the project name.
Click Next
Select the chip “LPC4330”
© 2016 CML Microsystems Plc 9 of 40 CL/PEO003/UM/3 February 2016
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Click Next

Select the required libraries:

In Select LPCOpen Libraries, click browse for LPCOpen Chip Library Project and select

“Ipc_chip_43xx”

In LPCOpen Board Library Project select “PEO003_DriverLib”.

r

o o 5T e S

Mew LPCXpresso C Project
LPCOpen Library Project Selection

Select the LPCOpen Chip and (optienally) Board library project(s) that you want your
new project to link against.

Selected library project(s) must be present in this workspace, If they -
are not, then click the Tmpert' button te run the Import Wizard
Select LPCOpen Libraries

LPCOpen Chip Library Project | Ipc_chip_43x¢

LPCOpen Board Library Project | PEO003 DriverLib

If a Board Library Project is selected, then the corresponding Chip Library Preject must
also be selected

For more information on LPCOpen, visit http://www.lpcware.com/Ipcopen.

P
K?Jl < Back ” Mext » Finish

Click Next.

‘CMSIS DSP Library Project Selection’ no changes required’

Click Next.

‘Part specific options ‘no changes required’

Click Next.

‘Other options ‘De-select ‘Code Read Protect (CRP)’ and select ‘Create ‘inc’ directory...’

© 2016 CML Microsystems Plc
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New LPCXpresso C Project
Other options

Code Read Protect (CRP)
[]Enable linker support for CRP:

See NXP documentation for your MCU at http://www.nxp.com/products/
microcontrollers for more information on CRP.

Project Structure

User source directory  src

Create 'inc’ directory and add to path

Compiler language dialect

C Dialect | Default n

@ <Back | Next> Fomar

Click Next

‘Memory Configuration Editor* no changes required
Click Next

‘Printf options’ no changes required

Click Finish.
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4.4 STEP 4 - Clean project folder
Remove the unwanted files generated by the wizard:
“crp.c “ — this provides code read protection and is not required

“sysinit.c” — initialises the PEO003 environment. This file is already included in PEO003_Driver.lib and could
be copied into your project.

[ Project Explorer 22 | 2. Peripherals+ 19} Registers = 0
= =
4 =5 BaseProject
> [ Includes
= inc
4 [ src

> || BaseProject.c

» 125 CML_UtilsLib
= Ipc_chip_43xx
» == PED003_DriverLib

© 2016 CML Microsystems Plc 12 of 40 CL/PEO003/UM/3 February 2016
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45 STEP 5 - Code base for your project

The wizard creates a top level source file, BaseProject.c. The contents should be replaced with the following:

#include "chip.h"

#include "pe0003.h"
#include "pe0003 config.h"
#include "ftdi.h"

#include "cbus.h"

#include "gpio.h"

#include "timer.h"
#include "lpc_types.h"

#include "monitor.h"
#include "messages.h"
#include "mon_general.h"

#tinclude <stdio.h>

//To use the GUI printfs
#tdefine printf mprintf
ttdefine scanf mscanf

int main(void)

{

// Initialise board
Pe@003_BoardInit();

//FTDI usb
Pe0@03_UsbFtdiInit();

// Initialise CBUS
Pe0003_CbusInit(CBUS1);
Pe0003_CbusInit(CBUS2);

//Init Timer
Pe@003_TimerInit();

//GPIO
Pe0003_GpioDedicatedIOInit();
Pe0003_GpioGenIOInit();
//Init GUI
Cml_GuiSystemInit();

mprintf("Hello from PE©OO3");

while(1)
{

}

return 1 ;

//Add code

© 2016 CML Microsystems Plc 13 of 40
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Notes:

e Chip.h — contains some configuration details for the chip and the basic data types
e Pe0003_config.h — contains the macros for the configuration

Inside Main() are these functions:

¢ Pe0003_BoardInit — configures all the pins and clocks for the PEO003 peripherals

e Pe0003_XXXXInit — initialises the PE0003 host’s peripherals with a default configuration

e Cml_GuiSystemInit — initialises and sets the link for the message-based communication with the
ECO0003

© 2016 CML Microsystems Plc 14 of 40 CL/PEO003/UM/3 February 2016
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4.6 STEP 6 - Configure properties

The wizard set-up will have done most of the job but not all, so there a few more configuration steps
required:

First, configure for ‘semihosting’ mode:
Select your project in the “Project Explorer” then right mouse click it and select “Properties”.
Select C/C++ Build - Settings. Inside Settings select MCULinker - Managed Linker Script.

In Library select ‘NewlibNano (semihost)’. Semihost mode allows the use of stdio.h, stdarg.h and other
system libraries, so it is possible to use printf and scanf for example.

Note: For communicating with EC0003 using printf the library mon_general.h has been added. It has an
implementation of printf called mprintf and scanf called mscanf. In the example code there is the macro ;
“#tdefine printf mprintf®

This converts printf into mprintf, used by EC0003. They work in the same way as the generic printf and
scanf.

.
Properties for BasePraject uﬂlﬁ
type filter text Settings oo o o
> Resource
Builders
4 C/C++ Build Configuration: ’Debug [ Active ] 'l ’Manage Configurations...

Build Variables
Environment

Logging & Tool Settings | # Build steps | Build Artifact I Binary Parsers I @ Error Parsers|
MCU settings
Settings 4 53 MCU C Compiler [¥] Manage linker script
Tool Chain Editor (2 Dialect [T]Enable Code Read Protect
. Cf/C++ General (2 Preprocessor Stack offset 0
Project References # Symbols
Refactoring History @ Includes Library IENewIibNano (semihost) R
Run/Debug Settings (2 Optimization [ Enable printf float

@ Debugging

@ Warnings

@ Miscellaneous

(2 Architecture
a B MCU Assembler

% General

(2 Architecture 8 Headers
a4 B MCU Linker

@ General

@ Libraries

@ Miscellaneous

(% Shared Library Settings

(2 Architecture

(% Managed Linker Script

(2 Multicore

[T Enable scanf fleat

"BaseProject_Debug.ld”

[ Restore Qefaults] ’ Apply ]

@ [ ok ][ cance |

© 2016 CML Microsystems Plc 15 of 40 CL/PEO003/UM/3 February 2016
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Second, add the remaining libraries.
In properties select C/C++ General - Paths and Symbols.

Select the References tab and then select ‘CML_UtilsLib’

— — B
Properties for BaseProject " [ =aiC g
type filter text Paths and Symbols e T
» Resource
Builders
. C/C++ Build Configuration: ’Debug [ Active ] '] ’Manage Coenfigurations...
4 C/C++ General
> Code Analysis
Documentation | (= Includesl # Symbols I =i Libraries | B Library Paths I 2 Source Location | B References |
File Types
Formatter » [ BaseProject Expand Al
Indexer 4 CML_UtilsLib
Language Mappings [Active] Collapse All [
Paths and Symbols [] Debug
Preprocessor Include P: [] Release Move Up
Project References » [] PEDOO3 DriverLib
Run/Debug Settings > [ Ipe_chip_43mx Move Down
P —T— o ’Restore Qefaults] ’ Apply ]
@ [ QK ] ’ Cancel ]
ks

In “Includes” tab, select GNU C then click “Add”.

Click ‘Workspace’ then select the library inc folder “/CML_UtilsLib/inc”

© 2016 CML Microsystems Plc 16 of 40 CL/PE0O003/UM/3 February 2016
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B ' Add directory path - ﬁ
Directory:
SCML_UtilsLib/ine
[ Add to all configurations
[] Add to all languages
25 Is a workspace path
OK ] ’ Cancel l
Click OK

Add the rest of the libraries in the same way if required; Ipc_chip_43xx/inc and
PEOOO3_DriverLib/inc.

Rearrange the order of the libraries, placing the most dependent libraries at the top and the less dependent
at the bottom. The image below has the libraries correctly rearranged. If the order is incorrect the linker may
report an ‘undefined reference’ error.

© 2016 CML Microsystems Plc 17 of 40 CL/PEO003/UM/3 February 2016
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F ™
i Properties for PR7261 [E=EER™x

type filter text Paths and Symbols T
[» Resource

Builders
[ C/C++ Build Configuration: ’D‘ebug [ Active ] '] ’Manage Configurations...

a C/C++ General
> Code Analysis

Documentation (1= Includes | # Symbols | = Librarit:l B Library Paths | 2 Source Location | 5 Referencs|

File Types
Formatter Languages Include directories Add..
Indexer e 1 =
Additional Assemb E'[J_—,-IS{Pro;Name}ﬁnc
) -E
Language Mappings Assembly €5 /CML_UtilsLib
Paths and Symbols GNU C 5 JCML_UtilsLibfinc

Preprocessor Include P:
Project References
| Run/Debug Settings

51 /PE00D3_DriverLib

51 /PEOD03_DriverLib/finc

5 /lpc_chip_43xx

5 flpc_chip_43x/ing

[ cifrxp/Ipexpresso_T.3.0_186/ Ipcxpresso/tools/lib/gec/arm-none-e..

Move Up

Mowve Down

[ cofrxp/Ipexpresso_T.3.0_186/Ipcxpresso/tools/lib/gec/arm-none-e...
| i3 c:/nxp/lpcxpresso_7.3.0_186/1pcxpresso/tools/arm-none-eabi/inl...

|
| |
@ "Preprocessor Include Paths, Macros etc.” property page may define additional entries
| [¥] Show built-in values
1
[ E%’ Import Settings... ] ?@ Export Settings...
|
|
] m b ’ Restore Qefaults] ’ Apply ]
[ @ | OK | [ Cancel l
A —_— — — Y
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Finally, LPCXpresso is configured for use with a debugger. By default, LPCXpresso will not generate the .bin
file used by EC0003 to program the PE00O3.

To generate the .bin file, in properties select C/C++ Build = Settings. Select Tab “Build steps” remove the
comment symbols ‘# in “Command:” text box, using the ‘Edit..." control.

—— N b
Properties for BaseProject E@g

type filter text Settings =14 r -
> Resource
-
Builders —
4 C/C++ Build Configuration: ’Debug [ Active ] '] [Manage Configurations...]

Build Variables
Environment

Logging B3 Tool Settings = Build steps | Build Artifactl Binary Parsersl (x] ErrorParsersl
MCU settings
Settings Pre-build steps
Tool Chain Editor Command:
a C/C++ General hd '

> Code Analysis

Documentation

File Types Description:
Formatter
-
Indexer
Language Mappings Post-build steps

Paths and Symbols

m

Command:

leMame}" "% BuildArtifactFileBaseMamel.bin" ; # checksum -p Y TargetChip

Preprocessor Include Pz
Project References
Run/Debug Settings

Description:

Perferming post-build steps -

@ [ ok ][ cance

Click OK.

© 2016 CML Microsystems Plc 19 of 40 CL/PE0O003/UM/3 February 2016
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5 Coding

Add project-specific libraries and code for the application.

5.1 Build your Project
Project-> Build all.

© 2016 CML Microsystems Plc 20 of 40 CL/PEO003/UM/3 February 2016
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6 Running the Project

There are three options for running the project:

e Using the generated .bin to be loaded via the EC0003 GUI. This option does not require a
debugger as the programme download is through the USB port to the PE0O003.

e Using a debugger. NXP provides the LPC-LINK2, a low-cost debugger that is supported in
LPCXpresso . The EC0003 interface can be used with the debugger, preloading the code with
LPCXpresso.

e Using the debugger and LPCXpresso without the EC0003 GUI.

6.1 Option 1- EC0003
Build the “.bin” file in LPCXpresso.

Connect the PE0O003 to the PC using a USB cable and power up the PEO0OQS.
Run EC0003.exe.

In EC0003, select Browse and navigate to the .bin file in the project folder. This will normally be found in the
Debug or Release folder.

Note: See the examples in section 9

6.2 Option 2 - Debugger + EC0003
Build the project in LPCXpresso.

6.2.1 STEP 1 - Create the launcher in LPCXpresso for loading the code into the chip.

In the Project Explorer, right-click the project. Select Launch Configurations > Create New...

Two new files appear in your Project folder called “ProjectName Debug.launch” and “ProjectName
Release.launch”. These files must be re-configured for use with the PE0O003. Right-click Debug.launch and
select Launch Configurations - Edit current.

Go to Debugger tab (For an LPC-LINLK2 Configuration):

- In “Emulator selection” select Redlink server.

- In Debug options template select NXP LPC43xx (SWD) (it is possible to use JTAG t00).

- In Debug options for NXP “Reset script” field. Browse Scripts and select
“‘LPC18LPC43RamReset.scp”. The PE0003 uses the LPC4330 and, because it is a flashless device,
the code runs from RAM.

Click Apply.

Connect the debugger then click Debug to load and run the program.

Once running, the main() function is highlighted and the debug commands from the menu or shortcuts
become active. It is possible to restart with the ‘Debug’ button in the toolbars. The configuration is

remembered.

Note. Before restarting a debug session, check that the previous debug session has completely stopped
otherwise LPCXpresso will stop with an error.

© 2016 CML Microsystems Plc 21 of 40 CL/PEO003/UM/3 February 2016
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*.1 Debug Configurations

e ____a T T et |

Create, manage, and run configurations

= )
CEX B2~ Name: BlinkLeds Debug
[type filter text| = Main 3‘&? Debugger [ Commeon E./ Source

a C/C++ (MXP Semiconductors) MCL
BlinkLeds Debug
BlinkLeds Release
[£] C/C++ Application
[E] C/C++ Attach to Application
[€] C/C++ Postmortem Debugger

Stop on startup at:  main [7 Force hardware breakpoint

Debugger Options

Target configuration ‘Main |

[£] C/C++ Remote Application
[£] GDB Hardware Debugging
= Launch Group

Debug options for NXP LPC4330 (cortex-m4)

Debug Connection | JTAG = | | Edit JTAG configuration

Configuration Option

abf: Additional options

|| Attach only

abf: Connect Script

atf: Debug Level

|iz| Debugger memory cache
|| Disconnect behavior

|| Load image

&) Maximum wire speed

lEl Memory Access Checking
af: Pre launch command

|2 Reset Handling

ahf: Reset Script

|l Run/Continue image

izl Semihosting support

|iz| Vector catch

L VY

Value

False

2
Disable
cont

True

off

LPC18LPC43RamReset.scp

cont
On

false

m

Miscellaneous

Emulator selection | CMSIS-DAP -

Debug opticns template

4| I k

Filter matched 9 of 9 items

@

NXP LPC430¢ (%) ~ [ Showall
Revert Apply
Debug ] [ Close

6.2.2 STEP2 - Connect to PEOO0O3

The EC0003 is a Graphical User Interface to ease the interaction with the PE0003. This allows user control
of the program, data to be displayed or saved to file and a host of other features of the PE0003.

Run EC0003.exe and toggle the Debug button. Once the code is loaded with the LPCXpresso click the

connection button to set the link then debug or run normally.

6.3 Option 3 - LPCXpresso debugger

This is similar to section 6.2.2 but does not use the EC0003 GUI application. Remove function call
Cml_GuiSystemlnit() from the project code. With this option it is not possible to use of any of the PEO003
features that require the EC0003 GUI such as downloading files or function images and dialog display. The
functionality of other libraries is available and the ‘semihost’ mode allows printfs to display information in the

LPCXpresso console.
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7 EC0003

This section describes the use of the EC0003 GUI application. There are two options for use:

e With a proprietary debugger and EC0003 acting as a display interface.

e Using standalone with the .bin file, generated by LPCXpresso or other compiler.

7.1 ECO0003 Basic Configuration
In the menu Tools - PEO003 Configuration.

-
& PED003 Cenfiguration

PE0003 Name |

[ ——
3000000

USE Data Rate

Cancel |

e

This control allows you to set the name of the board displayed at the top of the GUI or change the USB data
rate. It is not recommended to change the USB data rate because this also requires reconfiguration of the

firmware library.

From the menu, Tools = Environment variables

r! Enviroment Variables =Ny X
TVPE RX EString | Delete |
[ Reset | [ Add | [LoadFile| [ saveFil |
OK | Cancel |

L

-

Allows the user to set some environmental variables that can be read from the source code. The GUI
remembers the variable for the board hame and reloads them, every time the GUI is executed.
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7.2 Using EC0003 Standalone

To use EC0003 standalone it is necessary to load the compiled project as a .bin file.

To allow a new .bin file to be selected, the EC0003 GUI must be disconnected from the PEO003:

-,

-
&4 £C0003 NAME : TESTBOARD = | B |

File Tools Help

= |
Bin filename Browse L'S’?" Detect Changes  [[] Timestamp @

PEODO3 Detected...

Click Browse and select the .bin file for loading to the PEO0O03. If the PEO003 was previously loaded, the GUI
prompts the user to reset the PEO0O03 by pressing the reset button on the PE0O0O3.

Press PEDDO3 reset button...

The dialog will clear when the PEOOO3 reset button is pressed.
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To restart the project click the Reset control in the EC0003 GUI, see below. In this example an Fl load library
function has been called in the project code, resulting in the console messages shown.

&4 ECoo03 NAME : TESTBOARD

-

== X

Eile Tools Help

Bin filename | C\nxp\workspace\PE0601-7164_Gui\Debug\PEO601-7164 Gui.bin

Detect Changes [ Timestamp Reset m

Loading 7164F11.8.8.9

ProductId @x7164

FIVersion @x18e9

ProductId @x7164

FIVersion @&x18@9

FI loaded...

Product ID : 7164 FI Version : 1889

Manitor running...

S

If the Detect Changes checkbox is checked, the GUI monitors the selected .bin file for changes, normally as
a result of recompiling. If a change is detected the updated .bin will be loaded onto the PE0003

automatically.
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a EC0003 NAME : TESTBCARD
L -

o e |

File Tools Help

Bin filemame | C:\nxpworkspace\PE0601-7164_GuiDebug\PE0S01-7164 Gui.bin

Detect Changes

g

Loading 7164FI1.8.8.9

ProductId @x7164

FIVersion  8x18@9

ProductId @x7164

FIVersion  @x1@e9

FI loaded...

(|| Product ID : 7164 FI Version : 1889

Monitor running...
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7.3 Using EC0003 With a Debugger
Debugging can be done using both LPCXpresso and the EC0003 GUI.

The firmware is loaded into the PEO0O3 using one of three modes:
MODE 1

- Create a launch file. Locate the project in the “Project Explorer”. Right click the project and select
“Launch Configurations” > Create New...

- Or edit the launch configuration by right clicking the project and selecting “Launch Configurations” >
Edit current ...

o T — e S —
Debug Configurations @
Create, manage, and run configurations B ?
- EY
Al ER | = MName: PE0403_7340 Debug
D Main ﬁ Debugger 7“1‘4 Source| = Common

PE0003 Debug - i

PED003 Release C/C++ Application:

PED402 Debug Debug'\PED403_7340. axf

Eil]:gi F;EIEESZ Variables... ] [Searr_b Projact..‘] [ Browse... ]

T _Gui Debug

PED402_Gui Release Project:

PE0403_7340 Debug PEOA03 7240

PED403_7340 Release
PE0402_7240_Gui Debug
PED403 7340_Gui Release Build configuration: [Debug -
PE0GOL-7164_Gui Debug
PED601-7164_Gui Release

[£] C/C++ Application @ Enable auto build © Disable auto build

[£] C/C++ Attach to Application @ Use workspace settings Configure Workspace Settings...

[E] C/C++ Postmortem Debugger

[€] C/C++ Remote Application Connect process input & output to a terminal.

[] GDE Hardware Debugging

= Launch Group

Build (if required) before launching

[ Select configuration using 'C/C++ Application’

[

1 [ m ] ’
Appl Revert
Filter matched 37 of 37 items =

®

- Select the Debugger tab and configure the Emulator selection to “CMSIS-DAP”. Set the Debug
Connection to (SWD) or (JTAG) and in Target configuration, change Reset script to
LPC18LPC43RamReset.scp.
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¥4 Debug Configurstions W )

Create, ge, and run config
T B o -
[ &3 !I H 5P Mame  BlinkLeds Debug
Main %‘F Debugger 5| gommoﬂ E_/ Source]
a C/C++ (NXP Semiconductors) MCL

BlinkLeds Debug Stop on startup at  main [ Force hardware breakpoint

BlinkLeds Release

/C++ Application

C/C++ Attach to Application Debugger Options
C/C++ Postmortem Debugger Target configuration | Main |
C/C++ Remote Application
GDB Hardware Debugging Debug options for NXP LPC4330 (cortex-md)
= Launch Group X = = =
Debug Connection | ITAG
Configuration Option = Value il
ab: Additional options
¥ Attach only False
b Connect Script
at: Debug Level 2
2| Debugger memory cache Disable
|| Disconnect behavior cont
[ Load image True E

2] Maximum wire speed
]| Memory Access Checking off
ab[: Pre launch command

|| Reset Handling

| ab[: Reset Script LPC18LPC43RamReset.scp
&l Run/Continue image cont
&= Semihosting support On -
|| Vector catch false

TR s

Miscellaneous

Emulator selection | CMSIS-DAP -

Debug optiens template
NXP LPC43 (%) - | [[] Show all

4 il b
. ) Revert Apply
Filter matched 9 of 9 items =

| @ [ Debug || Close

- Click debug.

The configuration is saved so that future debug sessions can be launched by clicking the debug button
or using the menus.

MODE 2
This is basically the same as the previous configuration but access is through the Run menu.

- Run - Debug Configurations..

- If there is no launch file for the project, right-click C/C++ (NXP Semiconductor ) or one of the other
launch files. Select New.

- Select Debugger tab and configure Emulator selection to “CMSIS-DAP”. Set the Debug Connection
to (SWD) or (JTAG) and inside the box Reset script changed it to LPC18LPC43RamReset.scp.
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¥4 Debug Configurstions W )

Create, ge, and run config
T B o -
[ &3 !I H 5P Mame  BlinkLeds Debug
Main %‘F Debugger 5| gommoﬂ E_/ Source]
a C/C++ (NXP Semiconductors) MCL

BlinkLeds Debug Stop on startup at  main [ Force hardware breakpoint

BlinkLeds Release

/C++ Application

C/C++ Attach to Application Debugger Options
C/C++ Postmortem Debugger Target configuration | Main |
C/C++ Remote Application |
GDB Hardware Debugging Debug options for NXP LPC4330 (cortex-md)
= Launch Group X = = =
Debug Connection | ITAG
Configuration Option h Value il
ab: Additional options
¥ Attach only False
b Connect Script
at: Debug Level 2 N
2| Debugger memory cache Disable I
|| Disconnect behavior cont
[ Load image True E

2] Maximum wire speed

]| Memory Access Checking off
ab[: Pre launch command

|| Reset Handling

| ab[: Reset Script LPC18LPC43RamReset.scp
&l Run/Continue image cont
&= Semihosting support On -
|| Vector catch false

TR s

Miscellaneous

Emulator selection | CMSIS-DAP -

Debug optiens template
NXP LPC43 (%) - | [[] Show all

4 il b
. ) Revert Apply
Filter matched 9 of 9 items =

| @ [ Debug || Close

- Click debug.

The configuration is saved so that future debug sessions can be launched by clicking the debug button
or using the menus.

MODE 3

This mode can only be used after the Debug session has been configured. The shortcut button in the ribbon
is tied to the last configuration used by the debugger.

- Click the debug button.

|| 5@|(

In the figure above, the controls for debugging are displayed: Step into, step over, step through, pause,
resume, stop, restart.

Note : If a JTAG Configuration dialogue is displayed when configuring the Debugger then select Device 0
Cortec-M4
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i EE ™

JTAG Configuration
2 available JTAG Device(s) detected.
'Coresight DP' has been selected.
Deu:ice Mame TAP Id IRLen Details Scanchain

0  Coresight DP 04 bal0477 4 Cortex-M4 APID:24770011  --=TDO
/1 0x0bal1477 4 Cortex-MO0 APID:Unkno...  <--TDI

4 | 11§ | 3
@ [ OK J ’ Cancel ]

——

The following image is an example of an application that has been started in debug mode.

= [ PEOGO1-7164_... 52 | [c] timer.c ] core_crmd.h [ er_startup_|... [ er_startup_|...

34 #include "messages.h”

35 #include “mon_general.h”

36 #include “mon_fi.h"

37

38

39 //To use the GUI printfs
48 #define printf mprintf
41

42

43

44

45— int main(wvoid) {

46

47 // Initialise board

43 Pe@@d3 BoardInit();

49

58 //FTDT ush

51 Pe@@@z UshFtdiInit();
52

53

54 f// Initialise CBUS

55 Pe@@@3_CbusInit(CBUSL);
56 Pe@@@3_CbusInit(CBUS2);
57

58 //Inik Timer

59 Pe@dd3 TimerInit();

B8

61 //GPIO

m

ECO0003

For using the debugger with the EC0003, the button Debugger button must be switched enabled. This
informs the GUI that the firmware has been preloaded.
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.
&1 ECo003

NAME : TESTBOARD

File Tools Help

Ein filename

PE00Q3 Detected...

h

To enable or disable the connection to the PE0O003, click the connect button.

To restart the firmware in the board, click the reset button in the toolbar.

Detect €
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7.4 ECO0003 Console

If the timestamp checkbox is ticked a timestamp is displayed alongside each new line written to the console.

-~

&8 £Co003 NAME : TESTBOARD 2 =NREN X

Eile Tools Help

Bin filename | C\nxp\workspace\GuiMonitor_General\Debug\GuiMonitor_Genera Detect Changes Timestamp Reset ‘ m

[@@:88:89:009] | Hello from PE@@E3
[eP:0@:88:0824] | Insert number and string
[B8:08:08:026]
[@B:8@:88:724] | Mumber inserted 12
[@8:88:88:724] | String Hello

[@8:88:88:724] | Insert anything to continue...
[08:80:88:724]

Manitor running.

The File menu gives option for saving the console data to a file or for printing.

7.5 ECO0003 Features

The features implemented by the libraries in “CML_UtilsLib” follow: These files should not be modified by
users.

mon_general.h — handles basic operations in the EC0003 console such as printf, scanf, clear console and
reset.

mon_file.h — used to work with data files.

mon_fi.h — handling FIs using the interface GUI. For loading from SD card or memory directly without GUI or
human interaction use fi_tools.h.

mon_enviroment.h — used for reading environmental variables from the GUI.
mon_dialog.h — used to display dialogs and capture input from dialogs.
Monitor.h and messages.h — provides the message exchange system and messages used to communicate

with the PEO003. The most important function call to use for any project that needs interaction with EC0003
is:

//Init GUI
Cml_GuiSystemInit();

Note: Include this function call to enable communication between EC0003 and PEO0O03 otherwise the
ECO0003 GUI loads the firmware without interacting with the PE0003.
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8

LPC-Link2 Configuration

Since the release of LPCXpresso 7.9.2 (build 493) the default firmware was changed to CMSIS-
DAP, from Redlink. Due to this a new image has to be downloaded to the LPC-Link 2 board; the
“LPC-Link 2 Configuration Tool” provided by NXP can be used for this purpose.

Run the LPC-Link2 Configuration Tool. The LPC-Link2 board should be automatically recognised
by the program.

-
rogramimer, -Lini on uration Tool v2.
DFU prog /LPC-Link 2 Configuration Tool v2.02

File  Help

1:- Select a LPC-link 2 program image
[LPCLink2 CMSIS-DAP debugger with bridges -

LPC-Link 2 CMSIS-DAP debugger with UART/I2C/SPI bridges »

Use this image to odd CMSIS-DAP debugger and
UART/2C/5PI bridge debugger support to LPC-Link 2 boards.

Instructions: Remove jumper JP1 per the image.

‘Connect the board via USB to the system running this bl
program. Press the ‘Program’ button to program this
image into the board. Once programming is complete,
‘connect jumper JP1 and power cycle the board

[ Auto-program cumently selected Lnk2 image on board detection

Enable runime debug messages

1: Press the program button to program the board

Program the Link2 with the cumertly selected image

E PROG mode ~ HIGH SPEED USB

Select the image to program as CMSIS-DAP and follow the instructions provided in the small
window (basically program removing the jumper JP1 and connect it once the firmware has
successfully loaded). Click the button to Program.

A dialog window similar to that shown below should be displayed if the operation is successful.

-
[& DFU programmer/LPC-Link 2 Configuration Toal v2.02

File  Help

LPC-Link2 CMSIS-DAP debugger with bridges

LPC-Link 2 CMISIS-DAP debugger with UART/I2C/SPI bridges -

Link 2 boards

nstructions: Remove jumper JP1 per the image.
Connect the board via USB to the system running this
program. Press the “Program’ button to program this
mage into the board. Once programming is complete,
connect jumper IP1 and power cycle the board.

ol
L

Algorithm file : Simple CRC = : 1958578

Image file : Simple CRC =: 1811583

Downloading programming algorithm via DFU ROM boat
DFU programming algorthm download complete

Device detected: Programming algorithm

“Region size: 65536

“Erasing program area

“Program image inte Link2

“Starting verify operation®
Image verified by read back successful

E_PROG mode ~ HIGH SPEED USB

=
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Disconnect and reconnect the USB. Windows should automatically start to install the drivers

required.

-
 Driver Software Installation

Your device is ready to use

USB Compaosite Device q/ Ready to use
CMSIS-DAP +/ Ready to use
LPC-Linkll UCom Port (COM4) JReadyto use
LPC-5I0 Port q/Readyto use

Once installed in your LPCXpresso debug configuration remember to update the options

surrounded by red boxes in the following image.

-

- — -

1.4 Debug Configurations

Create, manage, and run configurations

CEX e Name:  BlinkLeds Debug

type filter text Meain [ (] Common [ %7 Source % Debugger
i 99

C/C++ (NXP Semiconductors) MCU Applic
o Stop onstartupat:  main

'
[E] C/C++ Application

[€] C/C++ Attach to Application Debugger Options

[€] C/C++ Postmortem Debugger Target configuration | pain

[ Ferce hardware breakpoint

[E] C/C++ Remote Application
[£] GDB Hardware Debugging Debug aptions for NXP LPC4330 (cortex-md)

B Launch Group
Debug Connectior] | SWD = [N Edit JTAG configuration

Configuration Option
[z2| Disconnect behavior
Load image

2] Maximum wire speed

[l Memory Access Checking
at]: Pre launch command

| Reset Handling

I =t[: Reset Script

4] Run/Continue image

|5l Semihosting support

3| Vector catch

<H]: Wirespeed (Hz)

Value .
cont
True

off

LPC18LPC43RamReset.scp

conl
On
false

(]

Miscellaneous

Emulator seIECt\urI CMSIS-DAP B I

Edit scripts..

Debug aptions template

NXP LPC43ucx () - | [1Showall

4 I 3

. ) Revert Apply

Filter matched 9 of 9 items

®
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9 Examples

Some example projects are provided with the EC0003 bundle. To work with the examples, run LPCXpresso
and create a new workspace for the examples.

Import (1O [
Select g
Create new projects from an archive file or directory. E 5
Select an import source:
type filter text
4 = General
[, Archive File
= Existing Projects inte Workspace
|, File System
25 Import projects(s) from XML description
EL Preferences
B C/C++
= Vs
= Install
(= Run/Debug
= Team

Use File = Import to open the Import dialog and under General select “Existing Projects into Workspace”.

Import all the projects from “Documents/CMLMicro/Examples”.

Build All projects.

To return to the original project, switch the workspace to your working space.

To switch workspaces in the LPCXpresso. Go to File - Switch Workspace - Other...

List of examples:

Project Description
BlinkLeds Blink the PEOOO3 LEDs D1-D4
CBusOperation Write and Read a C-BUS register, using a CMX7x4X or CMX7x3x device

GPIOOperation

Toggle the GPIO lines using a counter incremented every 100us.

GuiMonitor_Dialogs

Display sample dialogs using the EC0003 Monitor interface.

GuiMonitor_Environment

Configuring and using environment variables set in EC0003.

GuiMonitor_Files

PC File handling.

GuiMonitor_General

Example of mscanf and mprintf to send and receive data to/from the EC0003
GUI. Shows how to set the connection with the EC0003.

GuiMonitor_General2

Another example of scanf and printf but with a non-blocking scanf. A loop runs
continuously waiting for a “0” input to exit the loop and continue execution.

InterruptionlRQN

Use of the IRQN1 and IRQN2 interrupts.

PE0402

Loads an FI directly from the chip memory into a PE0402.

PE0402_Gui

Loads an FI from the EC0003 GUI using a dialog box targeting the PE0Q402

PE0403_7340

Loads an FI directly from the chip memory into a PE0403_7340.

PE0403_7340_Gui

Load an Fl from the EC0003 GUI using a dialog box targeting the PE0403 7340

PE0601 7164 _Gui

Loads an FI from the PC without a dialog.
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10 Known Issues List

There are some unresolved known issues:

- The Reset button may fail to trigger a reset during intensive USB operations. Toggling the Connect
button will resolve the problem.

- There can be a delay of around 15 seconds when starting the EC0003 application. This occurs if the
PC is connected to a network but does not have internet access. The problem is caused by the .NET
framework and does not occur if the PC has internet access or is completely disconnected from the
network.

- Dialogue boxes may not be displayed in the expected position if a multiscreen environment is used
and the screens have different resolutions.

- From LPCXpresso version 7.6.2 onwards, a problem was found using the NewLib library for
dynamic memory allocation. A hardware failure was caused by the use of the memory allocation
after some iterations.

- From LPCXpresso version 7.9.2 onwards, the configuration used for LPC Link 2 must be changed to
CMSIS-DAP. This requires an update of the firmware for the old LPC-Link2 debugger boards. Use
the LPC-Link2 Configuration Tool provided by NXP to set the right firmware.
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11 Summary

The PE0OO0O03 provides a set of libraries for developing and interacting with CML development kits.
The EC0003 provides an interface system to allow the user to interact with the application.

The Debug system using LPC-LINK2 provides a reliable method to debug user code.

More documentation about the libraries and how to use the tools can be found in section 13.

There are several examples on library use in the CML Bundle
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